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1 Introduction

1.1 DDClip Features
DDClip is non-destructive multitrack real-time audio and video editor.

DDClip is designed for projects where multimedia data have to be combined and
processed for final presentation - to score video, to synchronize voice with music,
to create audio commercials and others.

DDClip operates with multimedia data in form of “clip” and does not change
original content of source files. “Clip” contains a reference to a continuous frag-
ment of audio or/and video data from source file (clip may reference a whole file
content). It may be a number of nonoverlapping clips on a track.

DDClip is able to mix sound tracks in real time. This opportunity to get immediate
feedback to changes made in project makes DDClip an efficient editing tool.
Playback may by started at any time and for any part of project, any group of clips
or tracks.

With DDClip, it is easy to add clip to one of the project tracks, change relative or
absolute time position of a clip on or group of clips. Audio clips may have volume
and/or balance profiles, in addition to general volume and balance levels for
project and each clip. Fade may have special profile. Clips may be crossfaded. It is
possible to write from microphone or other external source simultaneously with
playback.

A short summary of DDClip features:
• video playback at any device supported by Video for Windows,
• track for MIDI,
• up to 16 tracks for audio,
• audio mixing in real time,
• solo/mute toggles for each track, available in real-time,
• volume and balance profiles for each clip on a track,
• multilevel Undo/Redo for editing features,
• context sensitive local menu on right-click with mouse.

Audio files may be in WAVE or AIFF formats (usually they have filename exten-
sions .WAV, .AVI, .AIFF, .AFF). A project should contain audio files with same
ratio. DDClip may convert initial material to same ratio when opening a clip.

The application works with one project at a time, project may be saved and re-
stored (file with filename extension .TML). Each project may have corresponding
clip collection file with extension .PRC.



1. Introduction

DDClip User's Guide2

1.2 Style conventions
Following style conventions are used in this guide:

Italics is used for names of windows, dialogs, buttons and various components.
Typically, description of these elements may be found in section with similar
name.

Boldfaced regular text is used to emphasis important features.

Bold text without serifs is used for menu items, names of panels and labels in dialogs.
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2 Installation and Registration

2.1 Installation
To install the software run SETUP program on DDClip CD-ROM.

This can be done in two ways:

Using the Windows Explorer:
1. Double-click My Computer icon on desktop.
2. Double-click icon for the CD-ROM drive.
2. Find the program SETUP.EXE in the list of files in the directory window.
3. Double-click on it.

Using the Run command:
1. Click the Start button on the Windows 95 taskbar.
2. Click Run command
3. In the Open box field type the drive letter of the installation media fol-

lowed by colon, back-slash and SETUP.EXE (e.g. E:\SETUP.EXE, if
your CD-ROM drive mapped on E:) or use the Browse button to locate
and select SETUP.EXE.

4.Press Enter.
The setup program screens are self-explanatory. Follow the instructions to specify
the destination directory and the software components to be installed.  The setup
program automatically creates the DDClip software group and the program items
and updates the system registry database with the necessary keys and values. This
completes the installation process and you are now ready to run the installed
DDClip software.

Note: The Typical software installation includes basic DDClip software and
sample project. The Compact installation option installs only basic DDClip soft-
ware the required low and medium level drivers for the DDClip.

Note: During installation process program may complain that it could not find
temporary directory. Choose existing subdirectory or create new subdirectory that
will be used as temporary (for example C:\TEMP). Then add following line to
AUTOEXEC.BAT file, located in first hard drive root directory (assumed that you
want to use C:\TEMP as temporary directory and it directory exists):

SET TEMP=C:\TEMP

Then restart computer. When you finish with installation you may remove the line
that you have add to AUTOXEC.BAT file.

2.2 Registration
Click About… on Help menu in application window, then click on Register now
button in dialog. In appearing dialog type in CD-Key1 and CD-Key2 numbers and
press OK. CD-Key numbers must be labeled on your CD-ROM box.
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If the program shows error message then check CD-Key1 and CD-Key2 strings and
click OK again.

2.3 Uninstall
To uninstall click the Start button on the Windows 95 taskbar, then click Programs,
then DDClip and Uninstall DDClip. Or run Add/Remove Programs from Windows 95
Control Panel, then select DDClip and click on Add/Remove… button.
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3 Overview

3.1 Clip. What does it mean?
Application operates with multimedia data in form of “clip” and does not change
original content of source files. “Clip” contains a reference to a continuous frag-
ment of audio or/and video data from source file (clip may reference a whole file
content). It may be a number of nonoverlapping clips on a track.

3.2 Quick start
At first, read carefully chapter 2 where described how to install (and uninstall) and
register application.

When application is launched general hints are – watch out cursor shape, call
context sensitive local menu with right mouse button click, use Toolbar buttons.
Settings dialog may help you to discover new features and tailor application be-
havior to your needs (to call dialog use Toolbar button or Options menu). Short
summary of basic operations with clip is in chapter 9.

The same editing commands and options may be available through global menu
item, toolbar button, accelerator key and local menu.

To get local menu called right-click on component.

To learn for what Toolbar button is for, you can rest your mouse pointer on the
button for a few seconds. Windows displays the button name.

Accelerator keys are displayed at right in global menu items. Complete list of
accelerator keys may be found in chapter 9 and in on-line help.

An alternative or compliment to this book reading is on-line help. It is available
from Help menu. Overview pictures of two application basic windows, Project
window and Clip Collection window, have links to component's descriptions. Click

over component when standard Windows help cursor change it's shape to .

Project window contains all data and tools for project editing. Clip Collection
window may be considered as a handy storage for references to audio and video
sources. Dedicated chapters in this manual describe each window and various
dialog windows in details. Separate chapter describes Settings dialog.
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3.3 Project Window

Figure 1  Project Window

Project window is a main application window. Typical layout is shown in Figure 1.

Project window title bar contains application name ‘DDClip’ and path to project
file or ‘Untitled’. Global menu provides accesses to commands and options.
Toolbar presents most frequently used commands.

Project window has Working Area, where parts of project tracks with clips are
available for editing. Each track to the left of Track Working Area has Track State
window with track type icon and Solo, Mute buttons, which control track inclusion
in playback. Clip on a track is displayed as rectangle with clip name in top left
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corner. Rectangle height is equal to track height, width is determined by clip
duration. Clip background color depends on Clip Selection state. Clips of different
types have type specific features.

All tracks and clips of a project are schematically presented in Project Overview
window. Time Ruler provides a project time reference for Working Area.

Two vertical red lines, one which cross Time Ruler, Range window and tracks in
Working Area, and one in Project Overview window visually represents current
time position. Current Time window show it’s value.

Right-click on different components displays a context sensitive local menu.

Status line at window bottom displays various information while moving around
with cursor.

All mentioned above and other Project window components are described in
sections of this chapter. Chapter 9 contains summary of basic clip management
operations, toolbar buttons descriptions and list of accelerator keys.

Project window supports Drag&Drop option for source files. ONE file at ones may
be dropped and placed on a track of appropriate type.

3.4 Clip Collection and other windows

Figure 2  Clip Collection Window

Clip Collection may be considered as a handy storage with references to audio and
video data. Each clip is represented by Clip Info window. Clips from Clip Collec-
tion can be dragged to Project window and back. Source files also can be dragged
from Windows Explorer window. When new source file is opening, a new Clip
with reference to whole file content is added to Clip Collection. Chapter 8 de-
scribes Clip Collection in more details.

Various dialogs can be called with commands on global and local menus. Some of
them shortly described below.
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Master volume and balance for project and audio tracks may be set in window, that
available with Audio meter (Faders) command on Project window Window menu.
Window also contains output volume indicator. Section 6.8.1 describes this win-
dow in details.

Section 4.8 describes other  Volume and Balance dialogs.

Audio Recorder dialog allows to write from microphone or other external source.
This can be done simultaneously with playback, if sound device support this
feature. Dialog described in section 6.4.1.

In Set Size dialog, section 5.8, in particular project duration and number of audio
tracks in project can be changed.

In Fade Profile dialog, section 6.7.1, shape of fade profile may be changed.

Clip name and other clip parameters can be viewed and changed in Edit Clip
dialog, see section 4.3.1, and Clip Properties dialog, section 8.3.

3.5 Clipboard
Clips in Clipboard preserve their relative time position and track number. Each
Cut/Copy command clears previous Clipboard contents. Copy/Add commands from
Clip Collection window add clips to first track only.
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4 Project Window Working Area

4.1 Working Area overview

Figure 3 Working Area.

Working Area represents project tracks with clips within specified time interval.
Interval bounds can be easily changed or redefined in Project Overview window,
where this interval is represented as bold black frame. In Set Size dialog values for
left and right bounds can be viewed or redefined. Working Area position relative to
project start and end project may be changed with horizontal scrollbar at bottom.
To the left of scrollbar zoom buttons are located, Zoom In (+), Zoom Out (-), Zoom to
Project (/) are also available in View menu, Zoom in range (*) in Range menu.

Vertical red line visually represents current time position.

In View menu items Show Video tracks, Show MIDI track and Show Audio tracks control
which types of tracks are presented in Working Area window. Vertical scrollbar to
the right of area occupied by audio tracks appears if not all audio tracks fit in
window.

Each track at its left has Track State window with track type icon and Solo and Mute
buttons.

“Clip” represents a continuous fragment of multimedia data from source file, in
particular clip may reference a whole file content. Clip also may have specific
properties such as volume and balance profiles for Audio clip.
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Clip on a track is displayed as rectangle with clip name in top left corner. Common
features and specific properties of Video/MIDI/Audio clips are described in sec-
tions of this chapter.

Right-click in area, which is not occupied by clips, calls local menu with following
items.

Open source file … call Open Clip dialog and add
clip with reference to whole
file content to project and Clip
Collection. File menu has iden-
tical item, please refer to menu
description for more details.

Cut. Copy. Paste. Insert. operations with selected
clip(s). Identical to items with same names on Edit
menu, see menu description for more details.

4.2 Track State window

Track State window at the left of each track in Working Area has Solo and Mute
toggle buttons and icon, which is specific for each type of tracks. Track may be of
Double, Normal, Half heights and a fourth of normal size in special ‘locked’ state.

Track may be included in or excluded from playback. Excluded track icon is
‘grayed’ and some picture details are removed, icons pairs presented below.

    - Video track.    - Audio track.    - MIDI track.

 - ‘Solo’ track always included in playback. Note that not ‘solo’ tracks are

automatically excluded from playback (‘grayed’), if there are ‘solo’ track(s).
Exclusive “Solo“ switch in Selection Settings dialog control if ‘solo’ may be set for
only one or for many tracks.

 - ‘Mute’ track excluded from playback (icon ‘grayed’).

 - Neither ‘solo’ or ‘mute’ track included in playback, if there is no ‘solo’

track.
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Audio tracks may also have ‘L’ and ‘R’ at top and bottom, if Stereo mode is set for
project in Audio tab of Settings dialog. These signs provide reference for balance
profile in Audio Clip.

Track name is displayed in status line at
Project window bottom while cursor is
located in Track State window. Track
Name dialog called from with Name item
in local menu. Predefined names typi-
cally indicate track type and number
inherited from initial enumeration of project tracks of that type.

Relative positions of tracks of the same type may be changed with Move up and
Move down commands in local menu. Note that first (top) video track has priority
over second video track during playback. Audio tracks have number in upper left
corner, which reflect current audio track enumeration from top to bottom. This
number is useful reference when not all tracks fit in window and vertical scrollbar
is used.

Right-click in whole window region or click in icon calls
local menu with items described below. Note that Track
Volume appears only for Audio and MIDI tracks.

Name call Track Name dialog, see above,
to change track name.

Move up swap this and upper track positions.
Move down swap this and lower tracks positions.
Double height display with twice normal height.
Normal height display with normal height.
Half height display with half of normal height.
Locked display with quarter of normal

height. Clips on ‘locked’ track can
not be selected and manipulated with
mouse, see also Clip Selection.

Track volume change track volume in special dialog window, see also sec-
tions 4.8 “Volume and Balance dialogs” and 6.8.1 “Audio
meter (Faders) windows”.

Solo always include in playback, same as Solo toggle, see above.
Mute exclude track from playback, same as Mute toggle, see above.

Height for all Audio tracks may be set from View menu, Audio tracks height.

4.3 Clip on a Track
Clip on a track is displayed as rectangle with clip name in top left corner. Rectan-
gle height is equal to track height, width is determined by clip duration. Clip
background color depends on Clip Selection state. Clips of different types have
specific features described in separate sections. Clip operations are summarized in
chapter 9.
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Right-click calls local menu that has to two groups of
items at top and bottom. Items that are described
below are common for all clip types. In Figure at
right MIDI clip local menu is presented as sample,
Tempo and Clip volume are specific for MIDI.

Play clip playback only this clip.
Delete clip delete this clip.
Edit clip parameters call Edit Clip dialog, see

below.
‘Clip type’ editor actual item name depends

on clip type and may be
Video editor, Audio editor, Midi
editor. Editor application is
launched with the clip
source file name added to
command line. ‘Editor’ path
may be set in Configure external applications dialog
(Configure on Tools menu).

Add mark set Place mark at specified position. Near place mark
cursor change its shape to . If local menu is called
near already set place mark when cursor has  shape
then Add mark is replaced by three items - Set mark position,
Mark name and Remove mark. See section 5.3 “Place marks”
for more details.

Split clip split clip in two parts at specified position, see Edit menu,
Split for more details.

Repeat clip call Repeat Clip dialog, see below.

Following commands are identical to items in Edit menu, see corresponding section
for more detailed description.

Cut cut selected clips to Clipboard.
Copy copy selected clips to Clipboard.
Paste add all clips from Clipboard to project starting at specified

position.
Insert split all clips at specified position, shift them and insert

clips from Clipboard in this gap. If there is video data then
current time and gap width aligns to frame boundaries.
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4.3.1 Edit Clip dialog
Clip local menu command Edit clip parameters calls this dialog.

Clip Name is an arbitrary
label that may be assigned
to a clip. By default, name
of source file is assigned.
Clips with different pa-
rameters may have same
name. Clip Name does not
identify clip uniquely.

File Name show path to
source file.

“Source position” group
fields presents in time
format selected in View
menu values of following
parameters:
In, Out – begin and end of clip relative to source file start position.
Size – clip duration, effectively difference between Out and In.
Source – duration of whole source file data.

Start and Stop are start end stop clip positions in project.

Show In/Out frame is identical to Show video in General Settings and Time Ruler local
menu. It controls if corresponding frame is displayed on videoplayer (Video win-
dow) while you change In or Out fields. Has meaning and available only for Video
clip.

4.3.2 Repeat Clip dialog
Clip local menu command
Repeat clip calls this dialog.
Each created copy became an
independent clip, but initially
clips except position in
project are identical. This is
true not only for general
properties such as clip
duration, position in source
file, place marks, but also for
clip type specific such as
volume and balance profiles for Audio clip.

Values of time position or time interval presented in time format selected in View
menu.
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Copy count sets the number of new copies. For example with counter value 4 there
will be 5 identical clips.
Time shows value for time interval occupied by new created repeated units, ‘period’
multiplied by number of copies.

Pause sets duration of pause before each new copy.
Clip  shows clip duration.
Period sets total duration of unit ‘pause + clip’ that will be repeated.

All parameters max values depend on free space after clip and are interdependent.
Beware that arbitrary values may be set while doing field editing. But sum of Pause
and Clip can not exceed Period. Period interval can not be set larger, if there is no
enough space for Copy count number additional copies, etc. It is recommended to
switch to another field with mouse of Tab key to see actual field value and then
press OK button.

Note that if time is measured in frames or SMPTE (see View menu), time interval
value is rounded to nearest frame start time. This may be a little bit misleading. In
figure above dialog was called for project with rate 10 frames per second and after
simple multiplication value ’00:00:09:02’ may be expected for Time field. To see
that everything is consistent choose Time in milliseconds selected in View menu.

4.4 Clip Selection
Delete, Move, Cut, Copy and some other operations operate with currently selected
clip or with group of selected clips.

Background color of rectangle that represents clip on a track depends on clip
selection state. Clips in current selection group are displayed in dark green. Clips
of other groups are displayed in dark blue. Unselected clips are displayed in dark
gray.

Click on unselected clip selects this clip and unselects other clips in current selec-
tion group.

Cursor shape  indicates that Multiselection mode is turned on from Toolbar, Edit
menu, or while Shift key is pressed). In this mode following actions invert clip
selection state (change selected to unselected and vice versa):
1) click on clip - invert this clip selection;
2) double click on track - invert selection for all clips on track after specified
position;
3) press left mouse button and drag - invert selection for all clips touched by or
within specified box.

It may be up to 9 clip selection groups. It is possible to change the number of
current clip selection group in Selection Settings dialog or with Next selection group
command in Toolbar or View menu.
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4.5 Video Tracks and Video Clip

Project may have one or two video tracks. During playback video first video track
has priority over second video track. Second video track may be used as temporary
storage for video fragments or as the second variant of the video when one track is
switched off with Mute button.

Application can playback and export video in the SAME format only. All clips
must have the same width, height, frame rate and CODEC name. Two files with
same width, height and frame rate but with different CODECs can be recom-
pressed with Convert AVI on Clip Collection window Tools menu. After starting
"AviEdit" application you can open the first file and look up its info. Then you
need to open the second file and choose video CODEC parameters the same as for
the first file CODEC.

Features that are common for all clips are described in section 4.3 “Clip on a
Track”. If Draw first and last frames at clip edges is checked in Video Settings then first
and last frame of the clip are displayed.

Right-click calls local menu. See also section
4.3 for general description. Video clip spe-
cific commands are described below:

Clip In is a key frame indicate that
video clip starts
from a key frame.

Clip In to next key frame move clip In position in source file forward to next
key frame.

Clip In to preceding key frame move clip In position in source file back to preceding
key frame.

In position mentioned above is a clip ‘start’ in source file. See also Start from Key
frame only in Video Settings for more details on key frame.

4.6 Audio Tracks and Audio Clip

Project may have up to 16 audio tracks.
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Features that are common for all clips are described in section 4.3 “Clip on a
Track”. Audio clip appearance depends on Clip Selection state. Sound waveform
picture is displayed in light blue color. Volume profile is displayed with blue lines,
balance profile - with magenta lines. Profiles key points is drawn in yellow.

Edit volume profile or Edit balance profile commands in Edit menu or Toolbar control,
which profile is available for editing (active). Inactive profile is drawn in dark
color (dark blue/dark magenta and dark yellow).

Besides volume and balance profiles, each audio clip has a general volume and
balance, see below Clip volume on local menu. Each audio track and whole project
also have the master volume and balance levels, see section 6.8.1 “Audio meter
(Faders) windows”. Volume at each point of clip is a sum (in dB) of volume
profile at this point and all master volumes (project master volume, track master
volume and clip master volume). The same is true for balance.

Attention! Maximum volume amplification is 12 dB (4 times). At points, where
maximum amplification is reached, profile touch the top of clip rectangle and stay
there while other profile key points may be moved with master volume change.
Thus the profile is distorted and mixed signal may not correspond to your expecta-
tion. To avoid this watch the clip volume profile - it should not touch top clip edge.

Right-click calls local menu. Common items are
described in section 4.3. Items specific for audio clip
listed below. Either volume or balance profile can be
edited at one time, see Edit volume profile and Edit
balance profile on Edit menu.

Clip volume call dialog named ‘Clip’ to
view/set master volume and
balance for this clip. See
also section 4.8 “Volume
and Balance dialogs” for
details.

Set profile volume call dialog named ‘Profile’ to set volume or balance pro-
file value at specified position. See also section 4.8 for
dialog details. Profile value may be changed for profile
key point or horizontal segment of profile. On slanted
segment of profile application at first calls dialog to con-
firm insertion of new key point at specified position.

Add profile point add new key point to profile at specified position.
Remove profile point remove key point at specified position.
Delete profile remove key points and set default profile - constant vol-

ume/balance level.
FadeIn apply (multiply) FadeIn profile to current volume profile

from start of clip to specified position. See section 6.7.1
“Fade profile dialog” for more details.
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FadeOut apply (multiply) FadeOut profile to current volume profile
from specified position to end of clip. See section 6.7.1 for
details.

4.7 MIDI Track and MIDI Clip

Audio clip appearance depends on Clip Selection state. At clip bottom midi meas-
ures are displayed.

At position, where source file has tempo or time signature change command, the
measure, current tempo and source tempo are displayed: ‘4/4,120[120]’.

Right-click calls local menu. Common items de-
scribed in section 4.3. Items specific for audio clip:

Tempo call Tempo dialog to modify clip
tempo, see below.

Clip volume call dialog named ‘Clip’ to view/set master volume for this clip.
See also section 4.8 “Volume and Balance dialogs” for details.

4.7.1 Tempo dialog
The number at bottom of the window shows original source file
tempo at specified position. The top number sets new tempo. The
tempo of whole clip will be changed in proportion new tempo (at
top) to original tempo (at bottom).
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4.8 Volume and Balance dialogs

  

Volume and/or balance dialogs may be called from various menus. Depending on
context, dialog may have either “Volume” or “Balance” group, or both groups.
Dialog has ‘Profile’ and ‘Clip’ labels when called with Set profile value and Clip
volume on Audio clip local menu. Label ‘Track’ has dialog when called with Track
Volume on Track State window local menu. Note that master volume and balance
for project and Audio tracks can be set in AudioMeter (Faders) window, see
section 6.8.1.

Balance value can be set from –100 (Left) to 100 (Right).

Nominal volume value is 0 dB or 100 %. Please see notes on maximum amplifica-
tion value in section 4.6 “Audio Tracks and Audio Clip”.
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5 Project Window components

5.1 Project Overview window

All tracks and clips of the project are schematically presented in this window. The
bold black frame determines position of Working Area - part of project, which is
displayed in window with video/midi/audio tracks. Red line – current time posi-
tion.

To shift the Working Area - move cursor inside frame (cursor shape became ) -
press left mouse button and drag frame.

To change Working Area size move left or right edge of working area - place
cursor over black frame edge (cursor became  or ) press left mouse button
and drag edge.

To completely redefine Working Area - press right mouse button at position of one
new edge, drag and release button where you want to set another new edge.

In Set Size dialog values for left and right Working Area edges can be set.

Project duration and number of audio tracks in project can be changed in Set Size
dialog and General Settings dialog.

Double click starts playback from pointed position to the end of project.

5.2 Time Ruler

Time Ruler provides a project time reference for Working Area. Each click in this
window redefines current time position, represented by vertical red line. ‘Scrub-
bing’ starts if you press left mouse button, hold it and then move mouse. Double
click starts playback from specified position to the end of working area.

Playback and scrubbing features and setting described in section on General Set-
tings, note that Show video, Play Audio and Auto-scroll rolls switches correspond to
items with same names in local menu.

Format of time label may be set in View menu, distance between labels chosen in
Scale Step list window.

Place marks (triangles with optional name) are described in section 5.3. Cursor
change shape to  near active place mark ( ).
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Right-click calls local menu. Note that Add Mark item
may be dynamically replaced.

Play playback project from speci-
fied position to the end of
working area.

Show video enable drawing of current
frame on videoplayer (Video
window). Identical to Show
video in General Settings and
Show In/Out frame in Edit Clip
dialog.

Play audio enable audio scrubbing with left mouse button dragging.
Set current time call Set Current Time dialog, see ‘Current Time window’

section.
Align to nearest frame enable aligning of current time to nearest frame position.

Same as switch in Alignment Settings.
Auto-scroll rolls control automatic scrolling of working area when mouse

moves outside the time ruler, see General Settings.
Attract to marks enable interaction of current time position with place

marks.
Add mark set place mark at specified position, item may be dynami-

cally replaced, see ‘Place Marks’ section.

5.3 Place marks
Place marks help on with alignment and synchronization of clips. Place mark
works during moving of selected clip(s). It attracts objects and keeps them while
object is within predefined distance from place mark. Object type, distance and
other alignment parameters are defined in Alignment Settings.

Place mark can be set in Time Ruler or in clip on a track. Time ruler place mark
has fixed ‘absolute’ project time. Place mark in a clip have fixed ‘source file’ time,
it always moves with the clip, clip resize operations have no effect on it.

When cursor approaches mark it change shape to  and mark may be dragged
with left mouse button. When you drag mark in Time Ruler you change current
time position also.

Time Ruler or clip local menus have place marks related commands:
Add mark set place mark at specified position.

Following items replace Add mark if local menu called with  cursor:
Set mark position call dialog to set mark position.
Mark name allow to set mark name.
Remove mark remove place mark.
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Place marks may be arranged in groups (up to 9 groups), only one group may be
active. Next mark group in Toolbar or View menu change active group in cycle.
Active group number may be set in Alignment Settings dialog.
Place mark of active group is displayed as solid green triangle. Place mark of
inactive group - as solid gray triangle.

How it works. Place mark attracts current time position (if this is not switched off
in Alignment Settings). Suppose that place mark is set in Time Ruler. When you drag
current time position and distance between it and place mark becomes less then
predefined, the current time position will jump to place mark position. While
distance between cursor and place mark is less then predefined distance then
current time will be kept at place mark. In similar ways alignment works with
various points in dragged clips. In Alignment Settings dialog you can select what
interacts with place marks: other place marks, edges of clips or mouse position.

5.4 Current Time window

This window to the left of Time Ruler displays
current time in format that may be set in View menu.
Double click in window calls Set Current Time
dialog.

In Project window two vertical red lines visually represent current time, first in
Project Overview window, second cross Time Ruler, Range window and tracks in
Working Area. Current time line may be dragged with mouse in Time Ruler and
Working Area.

5.5 Range Window

Range is a user defined time interval used in various operations. Window has same
time scale as Time Ruler. Selected interval is displayed in blue. If range is specified
then Range Flag window displays blue band, and Playback Start and Playback
Duration windows display range start time and duration in blue.

To specify range press left mouse button, drag and release. During mouse moving
the program displays current frame from video track, if Show video is on (see Time
Ruler local menu or General tab of Settings dialog). Shift-click reset nearest bound
to specified position. Double click set range, that cover all clips in project except
ones on switched off tracks; Include all clips on Range menu does the same.

To set/view range bounds in current time format double click in Range Flag
window or click on Set Size button to call Set Size dialog.
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Right-click calls local menu that has same items as
Range menu and two additional items:

Normalize audio… call Normalize Level dialog
where request maximum out-
put audio level then adjust
project master volume to
normalize audio.

Check overflow mix audio within range and
represent resulting audio vol-
ume as color picture in range
window in accordance with
volume levels and color asso-
ciations in Audio Meter Set-
tings.

5.6 Range Flag window

If this window to the left of Range Window has dark
blue band it indicates that range is defined otherwise it
is blank. Double click in window calls Set Range
dialog.

5.7 Playback Start and Playback Duration

These two windows show playback start time and playback duration. If range is
specified in Range Window then range start and duration are shown in blue. Oth-
erwise windows show Working Area start and size in black. Where playback
actually starts depends also on Start playback from current time position switch in
General Settings dialog.

Double click in either window calls Set Size dialog, see section íèæå.

5.8 Set Size
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Set Size button or double click
in either Playback Start or
Playback Duration windows
(see section âû øå) calls Set
Size dialog with three groups.

“Project Limits” group is
identical to and provides
same settings as group with
same name in General Settings
dialog. With Size and Audio
tracks project duration and
number of audio tracks in project may be changed.

In “Working Area” group left and right bounds of Working Area can be changed.

“Time Range” group provides same settings as Set Range dialog. Left and right
range bounds can be changed.

5.9 Scale Step

Interval between ticks with time labels in Time Ruler window may be selected
from list. This setting effectively zooms Working Area to size, which is natural for
selected scale.

If vertical red line that represents Current Time position is within Working Area
then ‘zoom’ preserve visual position of this line; otherwise center of Working Area
is preserved.

5.10 Zoom buttons
Four zoom buttons are located in low left corner of Project window. Zoom In (+),
Zoom Out (-), Zoom to Project (/) are also available on View menu; Zoom in range (*) on
Range menu.

 - set Working Area which cover whole project. Same as Zoom to project (/) on
View menu.

 - set Working Area with current time Range bounds. Same as Zoom in range (*)
on Range menu

 - expand Working Area at right. Same as Zoom In (+) on View menu.

 - shrink Working Area at right. Same as Zoom Out (–) on View menu.
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6 Project Window Menu
This chapter describes Project window global menu and submenus.

6.1 File menu
Project files have file name extension TML. Clip collection files have file name
extension PRC. Each project has associated clip collection file. Clip collection file
may be associated with multiple project files. Save project and Open project saves and
opens both files correspondingly.

New project create new (empty) project.
Open project open project and associated clip collection.
Add source File call Open Clip dialog to select source file, then add clip

with reference to whole source file content.
Save project save changes in project and clip collection files.
Save project As save project into specified project file. For new Clip Col-

lection clip collection file name also requested.
Save All copy project and clip collection and all source files into one

directory.
Export

AVI write resulting video and audio data into specified AVI-file.
Wave write resulting audio data into specified WAVE-file.
Aiff write resulting audio data into specified AIFF-file.

Exit exit from application.

Most recently used projects list may be inserted before Exit item.

6.1.1 Open Clip dialog

When called from Project window File menu add clip with reference to whole file
content to project and Clip Collection. In section 9.1 “Operations summary”
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described how to insert clip in Project window. Add source file on Clip Collection
Window File menu command adds clip only to Clip Collection.

Info area at right displays information about selected source file.

Preview button starts playback of selected file.

Auto preview enables automatic playback start when selection is changed.

Add button appears only if dialog is called from Clip Collection window, it adds
clip with selected source file to Clip Collection and does not close dialog.

6.2 Edit menu
Undo cancel last operation, if possible.
Redo repeat last canceled operation, if possible.
Delete remove selected clip(s).
Cut move selected clip(s) to Clipboard, see section 3.5.
Copy copy selected clip(s) to Clipboard.
Copy from file copy all clips from specified project file to Clipboard.
Paste add all clips from Clipboard to project at current time

position on free tracks.
Insert split all clips at current time position, shift them to right

and insert clips from Clipboard in this gap. If there is
video data then current time and gap width aligns to frame
boundaries.

Split split selected clip(s) in two parts at current time. If there is
video data then current time aligns to frame boundaries.
New clips preserve Clip Selection state of original and
have their own copy of volume and balance profiles.

Cross fade for two selected overlapped audio clips apply FadeOut to
left clip and FadeIn to right clip in overlapped region.

Edit volume profile enable editing of volume profile of audio clips.
Edit balance profile enable editing of balance profile of audio clips (for stereo

projects).
Add profile point mode cursor shape  indicates that mode is selected with but-

ton on Toolbar, on Edit menu or when Control key is
pressed. Each click in audio clip rectangle adds new point
to volume/balance profile at specified position.

Multiselection mode cursor shape  indicates that mode is selected with but-
ton on Toolbar, on Edit menu or when Shift key is pressed.
Each click selects/deselects clip. See Clip Selection sec-
tion for more details.

Select All select all clips (reset other selection groups).
Deselect All deselect all clips (reset other selection groups).
Invert selection select all unselected clips and deselect selected clips in

current group.
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6.3 View menu
Next mark Group change current Mark group number in cycle.
Next selection group change current Clip selection group number in cycle.
Show Video tracks enable displaying of video tracks.
Show Midi track enable displaying of midi track.
Show Audio tracks enable displaying of audio tracks.
Show audio meter(faders)shows Audio meter (Faders) window. Same as Audio meter

(Faders) on Window menu
Audio tracks height

Double set double height for all audio tracks.
Normal set normal height for all audio tracks.
Half set half height for all audio tracks.

Time in Frames display time labels as frame counter.
Time in SMPTE display time labels in SMPTE format.
Time in milliseconds display time labels in milliseconds.
Zoom In expand Working Area at right.
Zoom Out shrink Working Area at right.
Zoom to project set Working Area which cover whole project. See also

section 5.10 “Zoom buttons”.

6.4 Command menu
Play start playback of current project.
Stop stop playback.
Record audio request target file name (press Save button to continue

when you define file name) and call Audio Recorder dia-
log, see below.

Next frame set current time position to next frame.
Previous frame set current time position to previous frame.
Rewind set current time position to Playback start.
Master volume set project master Volume and Balance If the Audio meter

window was opened, the application activates it and sets
focus to master volume fader.

Normalize audio call Normalize Level dialog (see below), where request
maximum output audio level, then adjust project master
volume to normalize audio.

Check overflow mix audio in selected range and show resulting audio vol-
ume as color picture in Range window. The picture re-
flects volume according to color thresholds in Audio meter
Settings.
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6.4.1 Audio Recorder dialog

Ratio, Resolution, Stereo select recording audio parameters.

Meter controls displaying of input audio volume. For details see section 6.8.1
“Audio meter (Faders) windows”.

Always on top keeps recorder window on top.

Synchronize playback turns on playback of current project during recording. Play
command will be issued with Record button press.

Rec.Delay sets time between click on Record button and start of recording.

Status shows current state of recorder: Stopped, Recording or Pause.

Time shows time position in recording file.

< < or > > buttons rewind to begin or forward to end of recording file. The end of
recording file is the end of last recording fragment.

Prepare / Rec button makes preparations for recording process. After that label
changes to Record.

Record button starts recording.

Stop button stops recording. To record next fragment press Prepare / Rec button.

OK button closes dialog and inserts the written file in project and clip collection.

Cancel button closes dialog and deletes written file.
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6.4.2 Normalize Level dialog

This dialog can be called with Normalize audio on Edit menu or on Range window
local menu. It requests maximum output audio level and adjusts project master
volume.

The program mixes selected range and finds maximum volume. Project master
volume is adjusted to a value at which resulting maximum volume will be equal to
specified level.

This command does not change volume/balance profile, clip or track master
volume. It changes only the project master volume.

Attention! Maximum volume amplification is 12 dB (4 times). Thus, the program
can not normalize file with maximum level less than 25%. Second, if resulting
amplification for clip sample exceeds 12 dB then mixed signal may not correspond
to your expectation. To avoid this watch the clip volume profile - it should not
touch top clip edge.

6.5 Range menu
Range is a user defined time interval used in various operations It is displayed and
may be redefined in Range Window.

Commands operate on clips within range and on part of clips within range if range
bound crosses clip.

Zoom in range zoom working area to selected range bounds.
Include all clips range will cover all clips except clips on switched off

tracks
Copy…

all tracks copy clips from all tracks to Clipboard.
active tracks copy clips from active tracks to Clipboard.

Cut…
all tracks cut clips from all tracks to Clipboard and shift to left all

clips at right.
active tracks cut clips from Active tracks to Clipboard and shift to left

clips on Active tracks at right.
Clear…

all tracks remove clips from all tracks.
active tracks remove clips from Active tracks.

FadeIn…
all tracks apply FadeIn profile to clips on all tracks.
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active tracks apply FadeIn profile to clips on Active tracks.
selected clips apply FadeIn profile within range only to Selected clips.

FadeOut…
all tracks apply FadeOut profile to clips on all tracks.
active tracks apply FadeOut profile to clips on active tracks.
selected clips apply FadeOut profile within range only to Selected clips.

6.6 Tools menu
Each menu item launches corresponding application defined in Configure external
applications dialog.

Volume control start ‘volume control’.
Audio editor start ‘audio editor’.
Midi editor start ‘midi editor’.
Video editor start ‘video editor’.
ToolName1 actual item name set in Configure external applications

dialog and start corresponding tool. In accordance with
dialog that is shown below it should be Recorder.
… …

ToolName5 …
Configure… call Configure external applications dialog to set what

applications correspond to items on Tools menu.
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Path contains path to external application.
‘+ Clip filename’ control whether to add clip source file name to application com-
mand line.
Browse button allows to select application.

6.7 Options menu
Settings… call project Settings dialog described in chapter 7.
Fade profile call Fade Profile dialog, see below.
Font for Time mark choose font for displaying time code label.
Font for clip Name choose font for displaying clip name.
Clip name color choose color for displaying clip name.
Save Options safety program settings save. Application automatically

save current program settings on exit. These settings will
be used at program start. If application was terminated ab-
normally then program setting will not be saved and last
saved options are used.

6.7.1 Fade profile dialog
FadeIn and FadeOut commands on Audio clip local menu apply (multiply) fade
profile to current volume profile. Fade profile scales from start of clip to specified
position and from specified position to the end of clip correspondingly. CrossFade
on Edit menu is equivalent to FadeOut in first clip and FadeIn in second.

Fade profile dialog specifies FadeIn profile. FadeOut profile is time reversed
FadeIn profile. Note that except scaling profile is a global setting for all clips.
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The dialog shows fade profile in linear and logarithm scales. Between adjacent
points profile has linear interpolation (in logarithmic scale it looks like a bend).
When cursor approaches key point it change shape to . Click selects key point,
selected key point surrounded by pink square. To move point - press left mouse
button and drag. Key point can not be placed before and below previous point and
after and above next. First and last points can not be moved.

Linear buttons set points equidistantly in corresponding scale.
Volume allows to set volume of selected point in corresponding scale.

Point allows to change selection to point with specified number.
Time allows to set time of selected point.
Add point mode allows to add key points to profile. Each click in profile window
adds new key point.
Delete point deletes selected point from profile.

Save profile saves current profile into file (*.FPR).
Load profile loads profile from file.

6.8 Window menu
Clip Collection show Clip Collection window.
Audio meter (faders) show Audio meter (Faders) window.
Video show video preview window if possible.

6.8.1 Audio meter (Faders) windows
Audio meter (Faders) on Window menu activates window that can be shown as Faders
or A.Meter, depending on Faders switch state, see below:
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Window contains output volume indicator that displays
current volume during playback audio.

Indicator is divided into 5 intervals. Output audio
volume within each interval is painted in Dark Blue,
Blue, Green, Yellow and Red color consequently. Thin
lines mark maximum peak volume (if Peak hold is
enabled in Audio meter Settings). These marks are
removed at playback start. Mouse click in indicator also
removes them. Color intervals delimiting values,
displayed volume level range and reference text labels
presentation can be changed in Audio meter Settings.

Project master volume can be set with vertical fader or
by editing volume value in text box above it. Horizontal
fader and corresponding text box controls project
master balance.

Meter when checked enables monitoring of output audio
volume on indicator.

Faders control presence of faders at left. When unchecked dialog contains only
elements described above, and is named A.Meter. When checked dialog name is
Faders and dialog has track faders with Solo / Mute buttons.

Faders dialog shows 6 tracks faders. Track numbers are displayed at top. If current
project has less then 6 tracks then excessive faders will be grayed. If project has
more then 6 tracks scrollbar at bottom allows to select which 6 tracks will be
displayed.

You can dynamically change project and track volume and balance during play-
back.

Attention! Changes will always have predefined delay. This delay depends on
value of Buffer size in Audio Settings.

6.9 Help menu
Project window description show Project window description.
Clip Collection window description show Clip collection window description.
Overview show general application overview.
Contents show contents of the help.
Using help show help topic about using help in Windows.
About show dialog with information about application and it’s

authors. Click on Register now button start registration
process; see chapter 2 for details.
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7 Settings
Settings on Toolbar or Options menu call dialog with following panels:

General general project parameters.
Audio audio/midi parameters.
Video video parameters.
Troubleshooting troubleshooting options.
Audio meter volume indicator parameters.
Alignment alignment and Place Marks.
Selection selection parameters.
Save saving and autosaving parameters.
Colors customize color settings.
Summary information fields embedded in exported files.

7.1 General

“Project Limits” group.
Project size sets duration of the whole project.
Audio track number sets number of available audio tracks.

“Undo” group.
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Undo/Redo depth sets the number of Undo/Redo operations.

“Scrubbing” group parameters allows to control application behavior when chang-
ing current time in Time Ruler.
Show video enables drawing of current frame on videoplayer.
Play audio enables audio scrubbing with left mouse button dragging.
Sound playbacks in small pieces of Min. duration. If during the small piece play-
back current time is changed then next piece starts from new current time position.
While current time do not changes audio plays piece by piece up to Max duration; at
Max. duration it loopbacks from current position. In other words, Min value sets the
minimal duration of playing; if mouse is stopped when next piece playing is
started, duration will be Max.
Auto-scroll rolls changes scrolling mode of working area. When current time mark is
dragged outside Time Ruler the working area automatically shifts. If auto-scroll
rolls switch is turned on then working area slides smoothly while left mouse button
is pressed outside Time Ruler. Else when current time mark reach the working area
edge the working area shifts at a step. It looks like at in this moment time mark and
associated cursor jumps back from the shifted edge.

“Playback” group.
Start playback from current time position turns on ‘VTR playback’ mode. In this mode
command ‘Play’ starts playback from current time position. ‘Stop’ do not changes
current time position. When this switch is turned off the Playback Start and Play-
back Duration windows define playback start position. ‘Stop’ restores current time
position to one before playback.
Prompt before playback video control whether first frame of video will be displayed
and confirmation will be asked.
Repeat playback sets playback repeats count for command ‘Play’.
Hide cursor during playback – if checked current time mark will not be drawn over
project tracks. Current time line will be drawn in Time Ruler window only. This
option reduces system load during playback.
Enable solo/mute control during playback allows dynamically include/exclude audio
tracks from mixing during playback.
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7.2 Audio

“Output Format” group.
Ratio defines audio sampling ratio for the current project. First opened audio file
determines a project ratio. Predefined standard ratio may be selected from the list;
arbitrary ratio values can be set in professional version. If you change the project
ratio then all clips with audio will be removed from project. Change sound pa-
rameters dialog request confirmation to clear audio tracks.
Resolution selects number of bits per sample for current project.
Stereo turns on stereo mode for current project.

“Optimization” group allows to tune parameters to power of your PC.
Buffer size sets premix buffer size. In particular, premix buffer size determines delay
when track volume is dynamically changing during playback.
Playback through file turns off real time audio mixing. In this mode audio tracks will
be preliminary mixed in temporary file before playback. Application utilizes
optimized preliminary mixing algorithm. Only changed part of the project will be
remixed on next play.
Waveform control a quality of waveform pictures, which are displayed on audio
clips. Better picture takes more resources and may slow down application for
complex projects on some computers. Try decrease or turn off picture.

“Devices” group lists allow to select devices:
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Output - for playback audio (WAVE format).
Input - for recording audio (WAVE format).
Midi - for playback music (MIDI format).

7.3 Video

Frame rate sets project video frame rate. First video clip that added to project with
empty video tracks redefines this value.
Show information about dropped frames. During playback some video frames may be
dropped. When this box is checked dropped frame information will be displayed in
dialog window after playback.
Draw first and last frames at clip edges turn on drawing of first and last frames at left
and right edges of each video clip.
Start from Key frame only. Video in AVI-files may have not only key frames. If video
clip starts not from key frame then during playback first frames of this clip (up to
next key frame) may be drawn with a noise in Video window. Those frames will be
drawn with red border. When this switch is checked application prevents from
setting of clip left edge (time In) at not key frame. In any case exported AVI-file
will have correct video data.

“AVI” group.



7. Settings

DDClip User's Guide 37

Playback mode list selects mode of decompressing and drawing video data. Video
codec may not support some of playback modes.

Full screen - video codec decompresses and draws frames on external monitor or
full screen.
Decompress directly to window - video codec decompresses and draws frames di-
rectly in Video window.
Decompress and then draw - video codec only decompresses frames and applica-
tion draws them on videoplayer (Video window).
None - application will not playback video.
Default - application tries to find playback mode for codec starting from Full
screen mode.

Always on top keeps Video window always on top.
Synchronize to audio turns on synchronization of video playback to audio playback.
In this mode at audio playback delay a next video frame will have same delay.
Zoom list selects scale factor for Video window.

7.4 Troubleshooting

Some sound card’s Windows drivers can not correctly do playback and record
audio simultaneously. Successive start of playback and record sometimes may
help.
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Use playback starting delay in full-duplex mode turns on this mode.
Delay sets delay duration in milliseconds.

Reopen video codec at any operation. In this mode video codec is reopened at each
access. This allows to work correctly with hardware video codecs such as one for
miroVideo DC20. Attention! This mode may decrease video performance for most
video codecs.

7.5 Audio meter

Audio volume indicator is used in Audio Recorder and A.Meter(Faders) dialogs.
See section 6.8.1 ”Audio meter (Faders) windows” for detailed description of
indicator. Check overflow on Range Window local menu also utilizes associations
between volume level and its color representation.

 “Thresholds” group sets correspondence between audio volume level and color on
indicator. Delimiting values may descend from 0 dB to –96 dB. Intervals can not
overlap.

Meter Size defines an audio volume range presented on indicator. Top value is
always  ‘absolute’ digital 0 dB.
Peak hold enables display of peak mark (thin color band).
Always on top keeps audio meter/faders window always on top.
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“Labels” group control appearance of text labels.
Automatic display value in dB as label text and set reasonable distance between
labels. Otherwise, up to 10 pairs Volume – Name can be defined.
“0” position defines position of label “0” for automatic text labels. Note, that zero
shift or ‘0.000’ value is used by default.

7.6 Alignment

“Time alignment” group.
Align current time position to the nearest frame turns on alignment of current time
position and left edge of moving clips to the nearest video frame.
Attract current time position to place marks enables interaction of current time position
with Place marks.

“Place marks” group
Active group number selects group of Place marks which will be active. Other groups
became inactive.
Distance defines radius (in pixels) around place mark at which objects are automati-
cally caught.

“Attract to place marks” group defines which objects will be caught by place marks
during moving of selected clip(s):
None - nothing,
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Marks inside active group - active group marks interacts with each other only,
Mouse position - cursor position aligns to marks of active group. When cursor
remains within catching range, selected clip(s) are not moved.
Leftmost edge - leftmost edge of selected clips aligns to marks of active group,
Rightmost edge - rightmost edge of selected clips aligns to marks of active group,
Left edges - left edge of each selected clip aligns to marks of active group,
Right edges - right edges of each selected clip aligns to marks of active group,

7.7 Selection

Active group number sets active Clip selection group number. Other groups became
inactive.

Exclusive “Solo”. In this mode, if track is marked as “solo” then only this track will
be included in playback.

Do not drag current time position. If is not set current time position line is dragged,
when time range is defining in Range Window.
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7.8 Save

Save project and clip collection turns on saving of current project and clip collection at
specified period and/or after specified number of project changes.

Video stamp turns on saving thumbnail picture for each video clip in clip collection.
Waveform picture turns on saving picture of waveform for each audio clip in clip
collection.

Temporary directory defines directory for auto-save files and preliminary mixing file.
Read/Write access to this directory is required.
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7.9 Colors

Change color calls standard dialog, where new color can be set for item from list.
Color settings are reflected in picture. Item also can be selected by click in picture.
It is possible to keep mouse button pressed and move around with cursor.

Colors combination can be stored in files that by default have .CLT extension. To
save settings click Save scheme, then select directory and type a name.

Load Scheme allows to restore previously saved colors combination.

Default scheme reset to predefined colors.
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7.10 Summary

Various information fields can be embedded in exported audio and video data files
(Export command on Project window File menu). Some of these fields presented in
this dialog. Text string with up to 255 characters can be entered as field value.

Don’t export fields if not checked, then all non-empty fields will be included in
output. Two additional fields are always saved. One is a name of software package
“DDClip V2.23 Multitrack Audio and Video Editor”. Another is a creation date in
form YYYY-MM-DD; for example, “1998-05-01” for first of May 1998.

Extended allows to view and edit ALL available fields in Extended Summary dialog,
see section below.

Set as Default button allows to save all currently defined fields for later usage as
default settings for new created projects.
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7.10.1 Extended summary dialog

Fields that can be embedded in exported audio and video data files are available for
editing in this dialog. Some of them appear also in Summary Settings, see above.
Each field is presented by its short name and human readable name. Text string
with up to 255 characters can be entered as field value. If field has no associated
text string, it has “(Empty)” at the right in list box. Empty fields are not saved, see
also description of Don’t export fields switch in Summary Settings section above.

Reset button clear summary info.

Set as Default button allows saving of currently defined fields for later usage as
default settings for new created projects.
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8 Clip Collection Window

8.1 Clip Collection Overview

Clip Collection may be considered as a handy storage with references to audio and
video data. When source file is opening a new Clip with reference to whole file
content is added to Clip Collection.

Each clip is represented by Clip Info window. Clips from Clip Collection can be
dragged to Project window and back. Source files also can be dragged from Win-
dows Explorer window. To change position of Clip Info window drag it with left
mouse button or use Up/Down/Left/Right keys while Shift key is pressed. See section
9.3 for full list of accelerator keys for various operations.

Double-click in background calls Open Clip dialog to select source file, see section
6.1.1; then add clip with reference to whole source file content.

Right click in background calls local menu. Commands
at bottom control appearance of Clip Info windows, see
next section.

Add source File call Open Clip dialog to select
source file; then add clip with
reference to whole source file
content.

Paste add all clips from Clipboard to
Clip Collection.

8.2 Clip Info window
Window appearance has four variants: Full Info, Basic Info, Large Icons, Small Icons.
Current presentation can be selected on Clip Collection window Toolbar, on local
menu (right-click in background), on View menu.
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Following pictures shows what type(s) of multimedia data clip contains:

 ,  - Video clip.  ,  - Audio clip.  ,  - MIDI-sound.

If icon is grayed, that means that clip parameters differ from project settings. Tools
menu may help in conversion to desired parameters.

If clip contain both audio and video data, then both icons are displayed. If audio or
video is not used (Use Video and Use Audio in Clip Properties dialog, see section
below), then corresponding icon appears with red cross over it:

, , , .

Thumbnail picture for Video clip it can be chosen in Clip Properties dialog, Audio
and Midi clips has predefined pictures.

Full info presentation of Clip Info window is shown above, and is most informative.
It provides clip name, source file path, audio parameters (ratio, bits per sample,
stereo/mono or ‘No sound’), video parameters (width*height, frames per second or
‘No Video’), time In and time Out (beginning and end position in source file),
duration. Thumbnail picture is drawn at left.

Basic info is more compact. Except source file path, time In and time Out, it provides
same information as Full Info.

Large Icons and Small Icons presents only clip name, but have different sizes.

Note, that if clip from Clip Collection is not used in current project, then text
information, such as clip name, is drawn in blue.

Right-click on Clip Info window calls local menu that may contain following:
Play playback this clip.
Change project video parameters bring project video parameters in accordance

with clip video parameters.
Change project audio parameters bring project audio parameters in accordance

with clip audio parameters.
Launch ‘clip type’ editor actual command name depends on clip type

and may be Launch Video editor, Launch Audio
editor, Launch Midi editor. Editor application is
launched with the clip source file name added
to command line. ‘Editor’ path may be set in
Configure external applications dialog
(Configure on Tools menu).



8. Clip Collection Window

DDClip User's Guide 47

Copy clear Clipboard and add this clip to Clipboard (clip is
placed on first track).

Add add this clip to Clipboard (clips are added consequently
on first track).

Paste paste all clips from Clipboard in Clip Collection.
Delete remove this clip from Clip Collection.
Properties call Clip Properties dialog, see section below.

8.3 Clip Properties dialog
Properties command on Clip Info window local menu call this dialog. Dialog may
contain following tab panels:

General clip name, size, source file, etc.
Video, Audio, Midi multimedia data specific info. Use Video and Use Audio

switches.
Thumbnail frame for thumbnail picture.
Summary information field embedded into data source file.

8.3.1 General

Clip Name is an arbitrary label that may be associated to a clip. By default, a name of
source file is assigned. Clips with different parameters may have same name. Clip
name does not identify clip uniquely.
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File Name shows path to source file.
File Size shows source file size in bytes and kilobytes (KB), 1 KB=1024 bytes.
Created and Modified shows source file creation and modification date.

“Time” group fields presents in current time format (View menu) values of follow-
ing parameters:
In, Out – begin and end of clip in source file.
Duration – clip duration, effectively difference between Out and In.
Displayed values depends on current video Frame rate, see section below.

8.3.2 Video

This panel appears, if source file contain video data.

Use Video, if unchecked disables usage of video data from source file. This has
meaning when source file contains both video and audio.

“Format” group comprises following video parameters:
Frame rate is measured in frames per second and determines duration of playback
for video. Frame rate of source file is displayed in info area at right of Open Clip
dialog. Frame rate can be changed, if there is no clip(s) in current project that
reference video data in source file. NOTE, that current frame rate is used in calcu-
lations of In, Out, Duration fields in General panel, described in section above, and
Data rate and Duration described below. In no way frame rate changing affects
duration of audio playback. If both Use Video and Use Audio are enabled and current
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frame rate value is increased or decreased from one in source file, then on inserting
in project audio will be correspondingly truncated or extended with zeros. It may
be found convenient to duplicate clip, then enable only Use Video in one copy and
only Use Audio in another.
Width and Height presents geometrical parameters of video frame.
Codec name and short name provides two variants of video CODEC name.

“Source file” provides following information:
Data size shows size of video data in source file.
Data rate is calculated video data stream, see note above on Frame rate changing.
Duration shows how long it takes to playback all video that contain source file, time
value is presented in current time format, see View menu.

8.3.3 Audio

This panel appears, if source file contain audio data.

Use Audio, if unchecked disables usage of audio data from source file. This has
meaning when source file contains both video and audio.

“Format” group comprises following audio parameters:
Ratio is a number of samples per second.
Bits is a number of bits per sample.
Channels shows ‘mono’/’stereo’ for one or two channels correspondingly.

“Source file” provides following information:
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Data size shows size of audio date in source file.
Data rate is calculated audio data stream.
Duration shows how long it takes to playback all audio that contain source file, time
value is presented in current time format, see View menu.

8.3.4 Midi

This panel appears for source file with MIDI data.

Duration shows how long it takes to playback all data from source file. Time value
is presented in current time format, see View menu.
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8.3.5 Thumbnail picture

This panel appears, if source file contain video data.

Slide bar allows to select video frame, which will be used as identifying picture in
Clip Info window.
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8.3.6 Summary

Clip source file may have various embedded information fields. Some of these
fields are presented in this dialog. See also description of Summary Settings and
Extended Summary dialog in section 7.10.

Extended calls
dialog that pro-
vides information
on ALL fields, that
application under-
stands. If field has
no associated text
string, it has
“(Empty)” at the
right in list box.
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8.4 File menu
New collection create new (empty) clip collection.
Open collection open selected clip collection file.
Add source File add clip with whole source file content.
Add from collection add all clips from selected clip collection file to current

collection.
Save collection save changes in current clip collection file.
Save collection As save changes in new clip collection file.

Note that saved clip collections has file name extension .PRC.

List of most recently used clip collection files is appended after Save collection As.

8.5 Edit menu
Insert add new source file as clip to current clip collection.
Delete remove selected clip from current clip collection.
Properties call Clip Properties dialog, see section 8.3.
Synchronize project video parameters bring project video parameters in accordance

with this clip video parameters.
Synchronize project audio parameters bring project audio parameters in accordance

with this clip audio parameters.
Audio editor launch ‘audio editor’ application with the clip source file

name added to command line. ‘Audio editor’ path is de-
fined in Configure external applications dialog.

Midi editor launch ‘midi editor’ application with the clip source file
name added to command line. ‘Midi editor’ path is de-
fined in Configure external applications dialog.

Video editor launch ‘video editor’ application with the clip source file
name added to command line. ‘Video editor’ path is de-
fined in Configure external applications dialog.

Purge remove clips which not used in current Project from cur-
rent Clip Collection.

Add to Clipboard add this clip to Clipboard (clips are added consequently
on first track).

Copy to Clipboard clear Clipboard and add this clip to Clipboard (clip is
placed on first track).

Paste from Clipboard paste all clips from Clipboard in Clip Collection.

8.6 View menu
Full Info show maximum information about clips.
Basic Info show basic information about clips.
Large Icons show clips as large icons.
Small Icons show clips as small icons.
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Auto Sort sort clips in clip collection while add new clip.
Sort by Type sort clips in clip collection by it’s type in following order:

Video&Audio clips, Video clips, Audio clips, Midi clips.
Sort by Name sort clips in clip collection by clip name.
Time in Frames show time as frame counter. See Frame rate parameter in

Video Settings. Frame rate is measured in frames per sec-
ond (fps). For example, at 25 fps frame rate one second
time label will be displayed as “25” or “25fr”.

Time in SMPTE show time in format “hours:minutes:seconds:frames”, or
SMPTE. Last parameter is a frame number for current
second. One second time label will be displayed as
“00:00:01:00” or “00:00:01:00fr”.

Time in Milliseconds show time in as “hours:minutes:seconds:milliseconds”.
One second time label will be displayed as
“00:00:01:000” or “00:00:01:000ms”.

8.7 Tools menu
Convert WAVE convert source audio file into another WAVE-file with

different parameters. Choose input file and define output
file name. Then select desired parameters for output
WAVE-file and press OK.

Convert AVI launch “AviEdit” application that allows to convert source
AVI-file into another AVI-file with different parameters.

Convert MScamcorderAVI before use this command consider possibility to update
codec (see URLs below) and then use conventional
Convert AVI.
Alternatively, use Convert MScamcorderAVI. Choose source
file, then define output AVI-file. Source AVI will be
played on screen and grabbed into output AVI. Wait until
end of conversion, do not open or minimize windows, etc.

http://www.microsoft.com/workshop/imedia/netshow/netshow2/tools/cam.asp had
information on update of Microsoft Camcorder and link to file with update:
http://www.microsoft.com/ntserver/netshow/download/mscamupd.exe
Both URLs were last checked on 21st of July 1998.

8.8 Options menu
Font… select font for displaying clip information.
Color… select color for displaying clip name in “Small Icon”

mode.
Save Options safety program settings save. Application automatically

save current program settings on exit. These settings will
be used at program start. If application was terminated ab-
normally then program setting will not be saved and last
saved options are used.
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8.9 Window menu
Project show Project window.
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9 References

9.1 Operations summary
Cursor change it’s shape depending on which editing operation can be done.

Action Subaction Realization

Call local menu Click right mouse button.

Start playback Double click starts playback of project
from specified position to end of win-
dow.

Clip inserting Dragged clip (or source file) is displayed
as black rectangle.
Cursor may have one of following
shapes:

 - clip can not be inserted;

 - clip can be inserted at place of
black rectangle;

 - clip can be inserted but right part

of this track will be shifted to right as
whole.

Clip will be inserted at left mouse button
click.

Select one clip Click on desired clip.
Select clips Press left mouse button and drag. All

clips touched by or within specified box
selection will be selected.

Select/deselect
many clips

Press Shift key or turn on Multiselection
mode from Toolbar or Edit menu. With

 cursor, following actions invert

clip(s) selection state (change selected to
unselected and vice versa):

1) click on clip - for this clip;
2) double click - for all clips on track
after specified position;
3) press left mouse button and drag -
all clips touched by or within specified
box.

Selection

Clear selection Click on empty area.
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Moving Move selected clips  - press left mouse button and drag.
Move Left clip edge  - press left mouse button and drag

clip edge.
For clip with video first frame will be
displayed on videoplayer.

Move Right clip
edge

 - press left mouse button and drag
clip edge.
For clip with video last frame will be
displayed on videoplayer.

Move place mark  - press left mouse button and drag
mark.

Audio
volume/
Balance
profile
editing

Add key points to
audio profile

Press Control key or turn on Add profile
point mode from Toolbar or Edit menu. In
this mode cursor has shape . Each
click inside audio clip rectangle adds
new key point at specified position.

Move profile key
point

 - press left mouse button and drag.

Move horizontal
profile segment

 - press left mouse button and drag up

or down the horizontal segment of
profile (two key points of audio clip
profile with equal profile values).

Shift inclined/
vertical profile
segment

 - click left mouse button and drag to
left or to right the inclined/vertical
segment of profile (two key points of
audio clip profile with different profile
values).

Delete key point  - call local menu (right-click) and
select Remove profile point.

Clear audio profile Call local menu and select item Delete
profile. This reset profile to default 0Db
constant.

9.2 Project Window Accelerators

Action First accelerator Second accelerator
File operations

Open source file ‘F4’
New project Ctrl+’N’ Shift+’F3’
Open project Ctrl+’O’ ‘F3’
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Copy from project to clipboard Ctrl+Shift+’O’ Ctrl+’F3’
Save project Ctrl+’S’ ‘F2’
Save project as Ctrl+Shift+’S’ Shift+’F2’

Edit operations
Undo Ctrl+’Z’ Alt+’Backspace’
Redo Ctrl+’Y’ Alt+Shift+’Backspa

ce’
Delete ‘Delete’
Cut Ctrl+’X’ Shift+’Delete’
Copy Ctrl+’C’ Ctrl+’Insert’
Paste Ctrl+’V’ Shift+’Insert’
Insert Ctrl+’I’ ‘Insert’
Select all Ctrl+’A’
Unselect all Ctrl+’D’

Zoom operations
Zoom in Ctrl+’+’ ‘+’
Zoom out Ctrl+’-‘ ‘-‘
Show whole project Ctrl+’/’ ‘/’
Zoom in selected range Ctrl+’*’ ‘*’

Playback/cursor position operations
Start/Stop playback ‘Space’ ‘Enter’
Stop playback ‘Escape’
Rewind ‘Home’ Ctrl+’W’         ’W’
Go to next frame ‘Right arrow’
Go to previous frame ‘Left arrow‘

Scroll operations
Scroll working area to right Ctrl+’Right arrow’
Scroll working area to left Ctrl+’Left arrow’
Scroll audio tracks up Ctrl+’Up arrow’
Scroll audio tracks down Ctrl+’Down arrow’

Moving of selected clip(s) (with pressed left mouse button)
Move to upper track ’Up arrow’
Move to lower track ’Down arrow’
Shift 1 ms to right (audio/midi) ’Right arrow’
Shift 10 ms to right (audio/midi) Shift+’Right arrow’
Shift 100 ms to right
(audio/midi)

Ctrl+’Right arrow’

Shift 1 ms to left (audio/midi) ’Left arrow’
Shift 10 ms to left (audio/midi) Shift+’Left arrow’
Shift 100 ms to left (audio/midi) Ctrl+’Left arrow’
Shift 1 frame to right (video) ’Right arrow’
Shift 10 frames to right (video) Shift+’Right arrow’
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Shift 100 frames to right (video) Ctrl+’Right arrow’
Shift 1 frame to left (video) ’Left arrow’
Shift 10 frames to left (video) Shift+’Left arrow’
Shift 100 frames to left (video) Ctrl+’Left arrow’

Other operations
Activate Clip Collection
window

‘F6’

Exit Ctrl+’Q’

9.3 Clip Collection Accelerators

Action First accelerator Second accelerator
File operations

Open source file ‘Insert’ ‘F4’
New clip collection Ctrl+’N’ Shift+’F3’
Open clip collection Ctrl+’O’ ‘F3’
Add from clip collection Ctrl+Shift+’O’ Ctrl+’F3’
Save clip collection Ctrl+’S’ ‘F2’
Save clip collection as Ctrl+Shift+’S’ Shift+’F2’

Edit operations
Delete ‘Delete’
Add to clipboard Ctrl+Shift+’C’ Ctrl+Shift+’Insert’
Copy to clipboard Ctrl+’C’ Ctrl+’Insert’
Paste from clipboard Ctrl+’V’ Shift+’Insert’
Remove unused clips Shift+‘Delete’

Arrange operations
Move current clip up Shift+’Up arrow’
Move current clip down Shift+’Down arrow’
Move current clip to right Shift+’Right arrow’
Move current clip to left Shift+’Left arrow’

Select operations
Select upper clip ’Up arrow’
Select lower clip ’Down arrow’
Select right clip ’Right arrow’
Select left clip ’Left arrow’

Other operations
Playback ‘Enter’
Show project window ‘F6’
Exit Ctrl+’Q’


